Inequality and Race

hapter 9 explored gender inequality and sexism in the United States. This chapter

conducts a parallel investigation of racial inequality and racial prejudice. How much

inequality exists between white Americans and black, Hispanic, and Asian
Americans in education, jobs, and income? How strong is prejudice against black Americans?
Who is most likely to support racist beliefs?

THE LEGACY OF RACIAL AND ETHNIC INEQUALITY

Group inequality began in the infancy of U.S. society. During the colonial days of the 1600s
and 1700s, both African Americans and American Indians became unequal minority groups,
the first through slavery and the latter by military conquest. Later in the development of the
United States, other minority groups were created, including European immigrant groups
and Hispanic and Asian Americans. While some groups (e.g., the descendants of European
immigrants) found their way into the larger society and eventually achieved equality, other
groups—most notably the nonwhite groups—have been the victims of continuing exclusion,
discrimination, and racism, and substantial gaps remain between these groups and the larger
society.

One way to address the differences between groups and to better understand their rela-
tive positions today is suggested by sociologist Robert Blauner (1972), who distinguishes
between minority groups created by conquest and colonization and those created by immi-
gration. Minority groups created by conquest and colonization were created by coercion and
force, and their members were typically unwilling participants in the larger society. These
groups are often sharply different from the dominant group racially and/or culturally.
Minority groups created by immigration, on the other hand, typically enter the host society
voluntarily and often bring resources that they can use to defend their status and improve
their situation in the larger society. African Americans became a part of American society by
kidnapping and enslavement, and American Indians were created by military conquest and
subjugation. European immigrants and their descendants, in contrast, entered the United
States of their own free will (more or less) and were able to use the resources they brought
with them—including kinship networks, education, and money—to defend their interests
and promote their goals.

The Blauner hypothesis refers to the conditions under which a minority group enters the
larger society but its relevance extends for decades or even centuries after first contact:
Minority groups created by conquest or colonization will experience more intense prejudice,
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racism, and discrimination than those created by immigration. Furthermore, the disadvan-
taged status of colonized groups will persist longer and be more difficult to overcome than the
disadvantaged status faced by groups created by immigration (Blauner, 1972).

To apply the hypothesis to contemporary group relations in the United States, we would pre-
dict that groups created more by immigration—FEuropean immigrants and their descendants—
would compare quite favorably with national norms in terms of income, education, and other
measure of success. Groups created by conquest and coercion—African Americans and
American Indians—will compare less favorably on measures of success and equality. In other
words, the entry conditions of the group will continue to be reflected centuries later.

In this chapter, we will compare three minority groups with the “dominant group” (white
Americans): African Americans, Hispanic Americans, and Asian Americans. We will not con-
sider American Indians because they are a small group (less than 1% of the population) and
there are too few of them in the GSS sample to be included in any analysis. We will also not
separate out the descendants of European immigrants (e.g., Italian, Irish, German, or Polish
Americans), because census data show that these groups achieved equality by the time of the
1990 census, if not before.

Hispanic Americans (Mexican Americans, Puerto Ricans, Cubans, etc.) and Asian
Americans (Americans of Chinese, Japanese, Indian, Filipino, and Vietnamese descent
along with many other groups) are diverse groups that have been a part of American soci-
ety for many decades. The United States first came into contact with (and conquered)
Mexicans in the first half of the 19th century, and Asian groups began migrating in large
numbers about the same time. Today, as you are aware, both groups include many recent
immigrants, to the point that they may be considered a combination of colonized and
immigrant groups. Hispanic Americans have a stronger history of coercion (including mil-
itary conquests of Mexican Americans in what became the American Southwest and the
territory of Puerto Rico), and much of their recent immigrant stream includes people with
lower levels of education and occupational skills. Asian American groups were not subject
to military conquest. They are closer to being an immigrant group, and their recent immi-
grants are often people with high levels of education, English-language fluency, and occu-
pational skills.

Combining these facts and summarizing this discussion, we can hypothesize that, of the
three minority groups, African Americans (with the strongest history of colonization) will
have the lowest status on the average and Asian Americans (with the strongest history of
immigration) will have the highest status. Hispanic Americans (combining elements of both
coercion and immigration) will fall in between the other two groups.

EXERCISE 10.1 CHARTING THE MINORITY GROUP INEQUALITIES

We will explore these issues with the GSS-2006-Numerical data set by using line graphs (as
in Chapter 9) to display the degree of inequality between groups on four variables: years of
education (EDUC), occupational prestige (PRESTG80), income (INCOMEO06), and
WEALTH. To refresh your memory, these charts will display four lines, one for each group,
for each of the four variables. The greater the inequality between groups in the United States,
the greater the differences between the lines. As in Chapter 9, we will present the graph for
EDUC and leave most of the work to you. See Command Block 9.1 for instructions on get-
ting multiple line charts. Substitute RACEETH for SEX in the Define Lines By box and select
first EDUC, then PRESTG80, INCOMEO06, and WEALTH—one by one—in the Categories
Axis box. Make sure you select “% of cases” in the Lines Represent box. The multiple line
chart for EDUC is presented in Exhibit 10.1.
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Exhibit 10.1 Years of Education by Group
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You will generate a total of four graphs and it may be a good idea to print them out for
ease of reference. Each graph contains a lot of information so you need to read them care-
fully, remembering that the higher the line, the more common the score for that group.

For Exhibit 10.1, you can see that all lines have very high peaks at 12 years of education,
indicating that a high school degree is the most common level of educational attainment for
all four groups. A number of differences between the groups should emerge as you consider
the graph. For example, the line representing Asian Americans has high peaks at 16 and
20 years of education, much higher than any other group. This indicates that college and
graduate degrees are more common, proportionately speaking, for this group. Also, Hispanic
Americans have a noticeable peak at 6 years of education, a reflection of recent high rates of
entry for immigrants with modest educational credentials. What other differences can you
see? What do these differences mean in terms of inequality between groups in the United
States? Use this information and the other graphs to complete Research Report 10.1.
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RESEARCH REPORT 10.1
Multiple Line Chart for Four
Dependent Variables and Race or Ethnic Group

NAME

INSTRUCTOR

DATE

1.

4.

For Occupational Prestige (PRESTGS80)

As was the case in Chapter 9, the lines for the groups are quite jagged and hard to analyze. It may
be helpful to divide the chart roughly into thirds at scores of 40 and lower, 40 to 60, and 60 and
higher and look for which group(s) have the tallest peaks in each of the thirds.

A. Which group has the highest score in
1. the left-hand third of the chart (prestige scores less than 40)?
2. the middle third of the chart (scores between 40 and 60)?
3. the highest third of the chart (scores over 60)?
4. the very highest prestige scores (scores over 70)?

B. This chart indicates that the groups (are/are not) equal in occupational prestige.

. For Income (INCOMEOQ06)

A. Which group has the highest score in
1. the left-hand third of the chart (incomes of less than $20,000)?
2. the middle third of the chart (incomes between $20,000 and $75,000)?
3. the highest third of the chart (incomes more than $75,000)?
4. the very highest incomes (more than $110,000) ?

B. This chart indicates that the groups (are/are not) equal in income.

. For Wealth (WEALTH)

A. Which group has the highest score in
1. the left-hand third of the chart (wealth of less than $100,000)?
2. the middle third of the chart (wealth between $100,000 and $500,000)?
3. the highest third of the chart (wealth greater than $500,000)?

B. This chart indicates that the groups (are/are not) equal in wealth.

This pattern in these four graphs (including education) (is/is not) generally consistent with the
Blauner hypothesis. Explain.
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EXERCISE 10.2 TESTING RACIAL
INEQUALITIES FOR STATISTICAL SIGNIFICANCE

Because we are working with a random sample, we need to know if the differences between
minority and dominant groups on the four measures of inequality (EDUC, PRESTGS0,
WEALTH, and INCOMEO06) could have been produced by random chance. Because the
dependent variables are numerical and have many scores, the T Test procedure is appropri-
ate (see Chapter 9). We can use this procedure to find average scores for each minority group,
one at a time, and then test the difference with the dominant group (white Americans) for
statistical significance. If there is no inequality on the variable, the average of the minority
group will be roughly equal to white Americans. The more dissimilar the averages, the
greater the likelihood that the difference did not occur by random chance but rather reflects
patterns in the population (that is, differences between all members of each group and all
white Americans). We will continue to use the value of 0.05 to identify a statistically signifi-
cant result.

To run the T Test procedure (see Chapter 9), follow the instructions in Command Block 10.1.
The test variables will be EDUC, PRESTG80, WEALTH, and INCOMEO06 and RACEETH is
the grouping variable. You will run T Test three times, first with whites and blacks, then with
whites versus Asian Americans and, finally, with whites against Hispanic Americans. Follow
the instructions in Command Block 10.1 to identify the groups.

COMMAND BLOCK 10.1T Running T Test for Four Measures of

Inequality by Racial or Ethnic Group

¢ Click Analyze > Compare Means > Independent Samples T Test

¢ Highlight EDUC, PRESTG80, WEALTH, and INCOMEO6 and click the arrow pointing to the Test
Variable(s): box

¢ Highlight RACEETH and click the arrow pointing to the Grouping Variable: box

¢ Click the Define Groups button

e Click on the Group 1 box and type 1 (the code for white Americans)

e Click on the Group 2 box and type 2 (the code for black Americans)

¢ Click Continue

e Click OK

e These commands will generate the comparison between whites and blacks

¢ Click Analyze > Compare Means - Independent Samples T Test

¢ The four dependent variables will still be listed in the Test Variable(s): box

¢ Click in the Grouping Variable: box to activate it and then click the Define Groups button

¢ Leave the score of 1 (whites) in the Group 1 box but change “2” (African Americans) to “3” (Asian
Americans) in the Group 2 box

¢ Click Continue

e Click OK

o These commands will generate the comparison between whites and Asian Americans

¢ Click Analyze > Compare Means - Independent Samples T Test

¢ The four dependent variables will still be listed in the Test Variable(s): box

e Click in the Grouping Variable: box to activate it and then click the Define Groups button

e Leave the score of 1 (whites) in the Group 1 box but change “3” (Asian Americans) to “4”
(Hispanic Americans) in the Group 2 box

e Click Continue

e Click OK

e These commands will generate the comparison between whites and Hispanic Americans

e Print or Save these test results
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Reading the Output From T Test

We will analyze the results of whites and blacks here and leave the other comparisons to
you. SPSS produces two blocks of output for the T Test procedure. The first block (“Group
Statistics”), displays the average years of education for whites (13.61) and blacks (13.18)
under the heading of “Mean.” On the average, white Americans average more years of
schooling, by a little less than half a year, than black Americans. The statistical significance
of this difference is reported in the second block (“Independent Samples Test”). You will find
the ¢ score in the column labeled “t” and the p value in the top row of the column labeled
“Sig. (2-tailed).” This value (.048) is less than our standard criterion for a significant result
(.05). This means that the difference in average years of education is statistically significant.
In other words, it is unlikely that the difference in average scores between blacks and whites
was caused by chance. On the average, black Americans average significantly fewer years of
education than white Americans. As displayed in Exhibit 10.2, the differences for the other
three dependent variables are also significant. For all four tests, white Americans have sig-
nificantly higher scores than black Americans.

T Test for White and Black Americans (Modified SPSS Output)

Variable

Groups

Mean

Std. Dev

t score

p (“Sig. 2 Tailed”)

Education (EDUC)

Income (INCOMEO06)

Prestige(PRESTG80)

Wealth (WEALTH)

Whites
Blacks

Whites
Blacks

Whites
Blacks

Whites
Blacks

1060
200

911
166

1011
182

345
67

13.61
13.18

17.07
14.09

45.48
41.13

5.55
3.99

2.86
2.55

5.25
6.21

13.75
14.17

2.83
2.66

1.98

6.52

3.91

4.18

0.048

0.000

0.000

0.000

Of these four dependent variables, EDUC is the only one that has an exact, numerical
meaning. The total years of education—from 0 or no years to 20 years—was recorded for each
respondent, and SPSS computes averages by adding up the scores and dividing by the number
of cases. Scores for INCOMEO06 and WEALTH were recorded in broad categories rather than
exact dollar values. The average income for whites is reported as 17.07. This does not mean
that whites averaged $17 in income but, rather, that their average income fell in Category 17
of this variable. What does “17” mean? You can find out by consulting Appendix A of this text
or clicking Utilities > Variables on SPSS for the online code book. Either way, you will see
that a score of 17 includes incomes in the range $35,000 to $39,999. The average income for
black Americans (14.09) is in the category $22,500 to $24,999. Of course, it would be better
to have the actual incomes for both groups but these broad categories are more convenient for
respondents, even though it means that we have to work with less information.

Similarly, the average wealth of the groups can be understood in terms of the broad cate-
gories supplied to respondents. The mean for whites is in the middle of the $75,000 to
$100,000 range, while blacks average at the very top of the $20,000 to $40,000 category.
On the average, whites have about double the wealth of blacks.

Finally, the difference in occupational prestige (PRESTGS80) was also significant with
whites, on the average, ranking higher. See Chapter 8 for an explanation of the prestige scores.

Use the results of the #-test for the other group comparisons to complete Research Report 10.2.
Remember to look in the top row of the column labeled “Sig. (2-tailed)” for the probability
that the differences occurred by chance and do not reflect actual differences in the popula-
tion. Values of less than .05 indicate a statistically significant difference.
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RESEARCH REPORT 10.2
T-Test for EDUC, PRESTG80, and INCOMEO6 by RACEETH

INSTRUCTOR

DATE

1. Complete the following summary tables for the results of the ¢-test. This table is based on Exhibit 10.2
but includes only the most essential information.

Variable
Education (EDUC)

Income (INCOMEOQ06)

Prestige (PRESTG80)

Wealth (WEALTH)

Education (EDUC)

Income (INCOMEO06)

Prestige (PRESTGS80)

Wealth (WEALTH)

Groups

Whites

Asian Americans
Whites

Asian Americans
Whites

Asian Americans
Whites

Asian Americans
Whites

Hispanic Americans
Whites

Hispanic Americans
Whites

Hispanic Americans

Whites

Hispanic Americans

Mean

p (“Sig. 2
Tailed”)

(Continued)
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(Continued)

2. Using the group means, fill in the table below by ranking the groups from highest (rank of 1) to
lowest (rank of 4) separately on each of the dependent variables. Write the name of the group with
the highest mean score on each variable in the blank next to a rank of 1, and so forth.

Rank  Education  Rank  Income Rank  Prestige Rank  Wealth
1 1 1 1
2 2 2 2
3 3 3 3
4 4 4 4

3. Are these results generally consistent with the Blauner hypotheses? Use the graphs from Research
Report 10.1, Exhibit 10.2, and the results generated above to answer this question. Pay most
attention to differences that are statistically significant and large.

4. What conclusions can be made about racial inequality in the United States? How much inequality is
there? For which groups? Where does it exist? In educational achievement? In income? Occupational
prestige? In all areas?

5. Compare these results with Research Report 9.2. Which is greater: racial inequality or sexual
inequality? (You can determine this by comparing the amount and the significance of the differences
between group means.)
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EXERCISE 10.3 THE EXTENT AND CAUSES OF
ANTI-BLACK PREJUDICE IN THE UNITED STATES

Prejudice may be defined as an attitude toward other groups that combines negative feelings
or emotions (such as contempt or dislike) and negative ideas or stereotypes (such as the per-
ception that Jews are stingy, Irish are drunks, Italians are hot-tempered, or that African
Americans are irresponsible). How extensive is racial prejudice in the United States? We can
explore this issue with the GSS-2006-tabular data set. Load this data set now.

Selecting Respondents

Before analyzing anti-black racial prejudice, it makes sense to eliminate minority respon-
dents from the sample and focus on whites only. We can do this by choosing the Select Cases:
If command. This command is appropriate when we are interested only in cases with certain
characteristics or qualities. After the Select Cases: If command is executed, SPSS procedures
(such as Frequencies or Crosstabs) will be performed only on cases that have the character-
istics we specify. For example, we could confine the sample to older respondents, people who
reside on the East Coast, Democrats, and so forth. In this case, we will limit the sample to
white respondents only.

Begin by selecting Data from the menu bar and then click on Select Cases in the drop-
down menu. The Select Cases dialog box appears.

As you can see, there are several options for limiting or refining the sample. In our case, we
want to select cases if they are white, or have a score of “1” on RACEETH. Click the “If con-
dition is satisfied” radio button and then click the If button. The Select Cases: If dialog box
appears:
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Find RACEETH in the variable list to the left of the box and move it to the rectangle at the
top of the dialog box by clicking the right-pointing arrow. Now, select the equals (=) sign
from the calculator pad and the number 1. The expression in the rectangle should read
RACEETH = 1
Click Continue to return to the Select Cases: If box and then click OK. These commands
are summarized in Command Block 10.2.

COMMAND BLOCK 10.2 Selecting White Respondents Only

¢ Click Data > Select Cases

¢ From the Select Cases dialog box, click If condition is satisfied

o Click If

¢ In the Select Cases: If dialog box, highlight RACEETH and click the right-pointing arrow
¢ Click the = sign and the number 1 from the calculator pad

¢ Click Continue

e Click OK

After you execute this command, you will see some diagonal lines in the far left col-
umn of the SPSS Data Editor screen. These are the cases that are eliminated because they
don’t satisfy the condition specified in the Select If command (i.e., they are not white).
Once you have run the procedures in the next section, be sure to return to the Select
Cases command and click Reset at the bottom of the box. This will restore the sample
to its original composition.
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MEASURING PREJUDICE

Social scientists have developed numerous ways of measuring racial prejudice, and the GSS
includes a number of items that operationalize these feelings and stereotypes. One measure
of prejudice asked respondents to accept or reject each of four explanations for racial
inequality in the United States, one of which (RACDIF2) attributes racial inequality to the
inborn lack of ability of black Americans. Respondents who agree with this explanation pre-
sumably see blacks as inferior to whites. Thus, we will operationalize racial prejudice as
agreement with (or a response of “yes” to) this explanation of racial inequality.

We can use the Frequency procedure to determine the percentage of white respondents
who are prejudiced (that is, who agree with the “inborn ability” explanation of racial inequal-
ity). This will give an indication of the extent of prejudice in the United States.

Click Analyze > Descriptive Statistics = Frequencies from the menu bar. Select RACDIF2
from the variable list and click OK. Print and/or Save the table and use it to complete Item 1
in Research Report 10.3.

WHAT CAUSES PREJUDICE?

Beyond measuring the extent of prejudice, social scientists want to know something about its
causes. What types of white Americans would subscribe to the belief that black Americans are
innately inferior? Use your textbook or other course materials, if relevant, to identify two
possible causes of racial prejudice. Could education be a causal factor? Social class? Age?
Political ideology? Develop hypotheses linking your independent variables to RACDIF2 and
use the Crosstabs procedure, with column percentages, chi-square, and Cramer’s V (for non-
numerical independent variables) or gamma (for numerical independent variables) to evalu-
ate the strength and significance of the relationships. Use the output to complete Research
Report 10.3.
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RESEARCH REPORT 10.3
Measuring Racial Prejudice and Exploring Its Causes

NAME

INSTRUCTOR

DATE

1. Measuring the extent of racial prejudice: % of white Americans in the sample agreed (“yes” on
RACDIF2) that racial inequality is caused by the lack of ability of black Americans. Based on this
result, the degree of prejudice in the United States is (high/moderate/low). (You may want

to reserve judgment on the extent of prejudice in the United States until you complete Exercise 10.4.)

. Identify and explain your independent variables:

a. “SPSS” names:

b. Explain exactly what each variable measures.

Your first independent variable:

Your second independent variable:

. State a hypothesis for the relationship between each of your independent variables and RACDIF2. If

appropriate for your variables, state the anticipated direction of the relationship (positive or
negative). Explain why you expect a relationship between these variables:

Your first independent variable:

Your second independent variable:

. Present your results for your first independent variable and RACDIF2.

a. On Line 1 of the following summary table, state the name of your first independent variable. Use
common words, not SPSS variable names.

b. On Line 2, write in the name of your independent variable, again using common words.

c. On Line 3, write in the names of the categories of your independent variable, using as many
blanks as necessary.
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d. On Line 4, fill in the blank with the percentage of respondents who were prejudiced (said “yes”
on RACDIF2) for each category of the independent variable.

e. On Line 5, enter the values for each of the statistics.

1. Anti-Black Prejudice by (white respondents only)
2.
3. Prejudice
4. Percentage
“Yes”
S. Chi-square = p= Cramer’s V or Gamma =

5. Summarize these results:

a. The column percentages (do/do not) change, so there (is/is not) a relationship
between these variables.

b. Chi-square for this relationship is and the value for p is (less than/more than) .05,
so this relationship (is/is not) statistically significant.

If the independent variable is NOT numerical:

c. The value of Cramer’s Vis , so this is a (weak/moderate/strong) relationship.

d. The pattern of the relationship is that the highest level of prejudice is associated with
(identify the category of the independent variable that had the highest percentage
of prejudiced respondents).If the independent variable IS numerical:

If the independent variable IS numerical:

e. The value of gamma is , so this is a (weak/moderate/strong) relationship.
f. The sign of gamma indicates that this is a (positive/negative) relationship. As
increases, prejudice (increases/decreases). Be careful in interpreting direction.

6. Was your hypothesis confirmed? How?

7. Present your results for your second independent variable and RACDIF2.

a. On Line 1 of the following summary table, state the name of your second independent variable.
Use common words, not SPSS variable names.

b. On Line 2, write in the name of your independent variable, again using common words.



228 EXPLORING SOCIAL ISSUES

c. On Line 3, write in the names of the categories of your independent variable, using as many
blanks as necessary.

d. On Line 4, fill in the blank with the percentage of respondents who were prejudiced (“yes” on
RACDIF2) for each category of the independent variable.

e. On Line 3, enter the values for each of the statistics.

1. Anti-Black Prejudice by
2.
3. Prejudice
4. Percentage
“Yes”
S. Chi-square = p= Cramer’s V or Gamma =

8. Summarize and interpret these results:

a. The column percentages (do/do not) change, so there (is/is not) a relationship
between these variables.

b. Chi-square for this relationship is and the value for p is (less than/more than)
.05, so this relationship (is/is not) statistically significant.

If the independent variable is NOT numerical:

c. The value of Cramer’s V is , SO this is a (weak/moderate/strong) relationship.

d. The pattern of the relationship is that the highest level of prejudice is associated with
(identify the category of the independent variable that had the highest percentage
of prejudiced respondents).

If the independent variable IS numerical:

e. The value of gamma is , so this is a (weak/moderate/strong) relationship.
f. The sign of gamma indicates that this is a (positive/negative) relationship. As
increases, prejudice (increases/decreases). Be careful in interpreting
direction.

9. Were your hypotheses confirmed? How?
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EXERCISE 10.4 ANOTHER LOOK AT ANTI-BLACK
PREJUDICE IN THE UNITED STATES: MODERN RACISM

The frequency distribution for RACDIF2 indicates that only a small minority of white
Americans believe that black Americans are innately inferior. This result is consistent with
public opinion surveys over the past 50 years, which show that blatant racial prejudice has
declined and that the United States has become a more tolerant society.

Before congratulating ourselves too heartily on our greater tolerance, however, we need
to pay heed to another, less rosy view of America’s racial attitudes. A number of scholars have
been investigating the possibility that blatant racial prejudice hasn’t so much declined as it
has changed form and become more subtle and indirect (Bobo, 2001; Bonilla-Silva, 2006).
According to this line of research, prejudice has grown softer and less overt, but it remains
an important feature of American race relations.

This new form of prejudice is variously called colorblind, symbolic, or modern racism; a
measure of it is included in the list of explanations for racial inequality presented to respon-
dents in the GSS. For this exercise, modern racism can be operationalized as agreement with
the statement that “Most blacks just don’t have the motivation or willpower to pull them-
selves out of poverty” (RACDIF4). Presumably, those who agree with this explanation believe
that black Americans have the ability to close the racial gaps documented in Exhibit 10.2 but
choose not to do so.

[s agreement with this explanation really an expression of prejudice? The researchers who
have been studying modern racism point out that, first, this explanation of racial inequality
stereotypes black Americans and ascribes a single characteristic (lack of willpower) to the
entire community. Second, it places the blame for racial inequality on the victims rather than
on the overall society. That is, those who agree with RACDIF4 see the problem as residing
in African Americans, not in the structure or history of the United States.

Ultimately, however, the question of whether or not modern racism is a disguised version
of traditional American racial prejudice can be decided by research. If modern racism and tra-
ditional prejudice are different versions of the same underlying attitude, then RACDIF4
should “behave” like RACDIF2. If both variables measure prejudice, they should have simi-
lar causes, patterns, and consequences. There are at least three ways to explore the relation-
ship between RACDIF2 and RACDIF4.

First, use the Crosstabs procedure with RACDIF2 as the column variable and RACDIF4 as
the row variable. Request column percentages, chi-square, and gamma. If these variables are
different measures of the same underlying attitude, they should have a strong, significant rela-
tionship. Use the results of this procedure to complete Items 1 to 3 of Research Report 10.4.

Second, rerun one of the crosstab tables you produced for Research Report 10.3 with
RACDIF4 in place of RACDIF2. If RACDIF4 (modern racism) is a more subtle version of
RACDIF2 (traditional racial prejudice), the variables should have the same correlates and
should display similar (but not exactly the same) relationships with independent variables. In
other words, the crosstab table with RACDIF4 as the dependent variable should closely
resemble the table from Research Report 10.3 in which RACDIF2 was the dependent vari-
able. Use the results of this procedure to complete items 4 to 6 of Research Report 10.4.

Third, if both RACDIF2 and RACDIF4 are measures of prejudice, they should be related
in similar ways to measures of support for racial change. One such variable is MARBLCK,
which measures support for interracial marriages. Run the Crosstabs procedure with MAR-
BLCK as the row variable and RACDIF2 and RACDIF4 as the column variables. As usual, get
column percentages, chi-square, and gamma. If RACDIF4 and RACDIF2 both measure prej-
udice, they should have similar relationships (significance, strength, and direction) with
MARBLK. Use this output to complete Items 7 to 11 of Research Report 10.4.
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RESEARCH REPORT 10.4
Testing Traditional and Modern Racism

NAME

INSTRUCTOR

DATE

1. Summarize the results of comparing “traditional” prejudice (RACDIF2) and “modern” prejudice
(RACDIF4) by completing the table below. Fill in the blanks with the percentage of traditionally
prejudiced people (“yes” on RACDIF2) who are also “modern racists” (“yes” on RACDIF4) and the
percentage of traditionally unprejudiced people (“no” on RACDIF2) who are “modern racists”
(“yes” on RACDIF4).

Modern Racism (RACDIF4)by Traditional Prejudice (RACDIF2)
Traditional Prejudice
Modern Racism Yes No

Percentage “Yes”

Chi-square = p= Gamma =

2. Summarize and interpret these results:

a. The significance (p) of chi-square is , so the relationship between these variables
(is/is not) significant at the .05 level.

b. Gamma is , which indicates a (weak/moderate/strong) relationship in the
(negative/positive) direction.

3. Given these results, does it seem likely that RACDIF2 and RACDIF4 are different measures of the
same underlying attitude? Explain.

4. Summarize results for the crosstab table you redid from Research Report 10.3 using RACDIF4 as
the dependent variable.

a. On Line 1 of the following summary table, state the name of your independent variable. Use
common words, not SPSS variable names.

b. On Line 2, write in the name of your independent variable, again using common words.

c. On Line 3, write in the names of the categories of your independent variable, using as many
blanks as necessary.

d. On Line 4, fill in the blank with the percentage of respondents who were “modern racists” (said
“yes” on RACDIF4) for each category of the independent variable.

e. On Line 5, enter the values for each of the statistics.
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1. Modern Racism (RACDIF4) by

3. Modern
Racism

4. Percentage
“Yes”

S. Chi-square = p= Cramer’s V or Gamma =

5. Summarize the results:

a. The column percentages (do/do not) change, so there (is/is not) a relationship
between these variables.

b. Chi-square for this relationship is and the value for p is (less than/more than) .05,
so this relationship (is/is not) statistically significant.

If the independent variable is NOT numerical:

c. The value of Cramer’s V is , o this is a (weak/moderate/strong) relationship.

d. The pattern of the relationship is that the highest level of modern racism is associated with
(identify the category of the independent variable that had the highest percentage of
people who said “yes” on RACDIF4).

If the independent variable IS numerical:

e. The value of gamma is , SO this is a (weak/moderate/strong) relationship.
f. The sign of gamma indicates that this is a (positive/negative) relationship. As
increases, modern racism (increases/decreases). Be careful in interpreting direction.

6. Compare this table with the one you created for Research Report 10.3. Were the relationships
between your independent variable and RACDIF4 generally the same as the relationships between
your independent variable and RACDIF2? Use column percentages, the significance of chi-square,
and your measure of association to make the comparisons. Do these results support the view that
RACDIF2 and RACDIF4 are closely related? Explain.

7. For the analysis of support for racial intermarriage (MARBLK) and traditional prejudice
(RACDIF2), complete the following table by filling in the percent of the sample that was opposed
to racial intermarriage for each response to the measure of traditional prejudice.

(Continued)



232 EXPLORING SOCIAL ISSUES

(Continued)

Attitude on Racial Intermarriage by Traditional Prejudice (RACDIF2)
Traditional Prejudice (RACDIF2)
Racial Intermarriage Yes (prejudiced) No (not prejudiced)

Percentage Opposed

Chi-square = p= Gamma =
8. Summarize the results.

a. The column percentages (do/do not) change, so there (is/is not) a relationship
between these variables.

b. Chi-square for this relationship is and the value for p is (less than/more than)
.05, so this relationship (is/is not) statistically significant.

c. The value of gamma is , so this is a (weak/moderate/strong) relationship.

d. The sign of gamma indicates that this is a (positive/negative) relationship. As traditional
prejudice increases, opposition to interracial marriage (increases/decreases). Be

careful in interpreting direction.

9. For the analysis of support for racial intermarriage (MARBLK) and modern racism (RACDIF4),
complete the following table by filling in the percent of the sample that was opposed to racial
intermarriage for each response to the measure of modern racism.

Attitude on Racial Intermarriage by Modern Racism (RACDIF4)

Modern Racism (RACDIF4)
Racial Intermarriage Yes (prejudiced) No (not prejudiced)
Percentage Opposed

Chi-square = p= Gamma =

10. Summarize the results.

a. The column percentages (do/do not) change, so there (is/is not) a relationship
between these variables.

b. Chi-square for this relationship is and the value for p is (less than/more than)
.05, so this relationship (is/is not) statistically significant.

c. The value of gamma is , so this is a (weak/moderate/strong) relationship.

d. The sign of gamma indicates that this is a (positive/negative) relationship. As modern
racism increases, opposition to interracial marriage (increases/decreases). Be careful

in interpreting direction.

11. The measures of traditional prejudice (RACDIF2) and modern racism (RACDIF4) have
(similar/dissimilar) relationships with attitudes toward interracial marriage. These results
(support/do not support) the idea that RACDIF2 and RACDIF4 both measure prejudice. Explain.

12. Looking over these results, what conclusions can be made with regard to the idea that prejudice has
not declined but has changed to a less blatant form? Are these results consistent with the notion that
prejudice, even in disguised form, is still an important factor in American race relations? Explain.
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EXERCISE 10.5 A MULTIVARIATE
ANALYSIS OF PREJUDICE AND SOCIAL CLASS

Prejudice is a complex phenomenon with a variety of forms and causes. One independent
variable frequently linked to prejudice is competition between groups over scarce resources
such as jobs, schools, or housing. As intergroup competition increases, prejudice intensifies
and group members who feel the most threatened tend to be the most prejudiced (see Bobo,
1999; Bonacich, 1972; King & Weiner, 2007; Noel, 1968; Sherif, Harvey, White, Hood, &
Sherif, 1961).

Given the historical patterns of racial inequality in the United States, we can hypothesize
that, for white Americans, racial prejudice will be strongest in the lowest income groups—
those most likely to fear displacement by increases (real or perceived) in the status of minor-
ity groups. Test this idea on the GSS-2006-tabular data set by running the Crosstabs
procedure with INCOME as the independent variable (in the columns) and RACDIF2 as the
dependent variable. Don’t forget column percentages, chi-square, and gamma. Use the results
to complete Item 1 in Research Report 10.5. (You may have already explored the relation-
ship between RACDIF2 and INCOME for Research Report 10.3. If so, simply copy your
results to Research Report 10.5.)

Would the relationship between RACDIF2 and INCOME be the same for females as for
males? Would the difference in income levels of men and women (see Chapter 9) lead to dif-
ferences in levels of threat? Would low-income white women feel particularly threatened by
racial change? We can answer these questions by observing the effect of SEX on the rela-
tionship between prejudice and income level. Run the Crosstabs procedure again and name
SEX as the control variable by moving it to the bottom box in the Crosstabs dialog box. Use
the output to complete Item 2 in Research Report 10.5.

What other control variables might affect the relationship between social class and preju-
dice? Would age be relevant? Would older, lower income whites feel more or less threatened
than younger, lower income whites? How about political ideology (POLVIEWS)? Education
(DEGREE)? Pick another control variable and run the Crosstabs procedure again, placing
your control variable in the bottom or “layer” box of the Crosstabs dialog box. Remember
that control variables should have only two or three categories or scores. Use the output to
complete Item 3 in Research Report 10.5.
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NAME

EXPLORING SOCIAL ISSUES

RESEARCH REPORT 10.5
Analyzing Social Class and Prejudice

INSTRUCTOR

DATE

1. Summarize results for RACDIF2 and INCOME by filling in the blanks with the percentage of
respondents who were prejudiced (“yes” on RACDIF2) for each income category. Also fill in the

values for the statistics.

Traditional Prejudice by Income

Prejudice Low

Percentage “Yes”

Chi-square =

Income

Moderate High

p= Gamma =

2. Summarize the results:

a. The column percentages
between these variables.

b. Chi-square for this relationship is

.05, so this relationship

c. The value of gamma is , so this is a

d. The sign of gamma indicates that this is a

increases, traditional prejudice
direction.

(do/do not) change, so there

and the value for p is
(is/is not) statistically significant.

(is/is not) a relationship
(less than/more than)
(weak/moderate/strong) relationship.

(positive/negative) relationship. As income
(increases/decreases). Be careful in interpreting

3. Do these results support the idea that competition and sense of threat are a cause of prejudice?

Explain.

4. Complete the following summary table to display the results of the multivariate analysis of
traditional prejudice (RACDIF2) and INCOME while controlling for SEX. In Line 1, copy the
percentage of prejudiced respondents (“yes” on RACDIF2) from the table in Item 1 of this Research
Report and report the significance of chi-square and the value of gamma. In Line 2, fill in the
percentage of prejudiced males for each income category, along with the significance of chi-square
and gamma, and do the same for prejudiced women in Line 3.
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Traditional Prejudice by Income by Sex

Income
Percentage Significance
Line Prejudiced Low Moderate High of chi-square Gamma
1. All o
2. Men .
3. Women

5. Use the column percentages and gamma to analyze these results. Were prejudice and income related
in the same way for both men and women? What differences and similarities can you identify?
Which subgroup (combining sex and income) is more prejudiced? Which is less prejudiced? Explain.

6. Complete the following summary table to display the results of the multivariate analysis of traditional
prejudice (RACDIF2) and income while controlling for the variable you selected. In Line 1, fill in the
blank with the name of your control variable. In Line 4, copy the percentage of prejudiced
respondents (“yes” on RACDIF2) from Item 1 of this Research Report for each category of income
and also note the significance of chi-square and the value of gamma for the bivariate relationship. In
Line 5, fill in the percentage of prejudiced respondents for the first category of your control variable.
In Line 6, do the same for the second category of your control variable. If necessary, use Line 7 and
Line 8 to fill in the percentage of prejudiced respondents for the third and fourth category of your
control variable.

1. Traditional Prejudice by Income by
2. Income
3. Percentage Significance

Prejudiced Low Moderate High of Chi-Square Gamma
4. All -
S. -
6. -
7. _
8. -

7. Use the column percentages and gamma to analyze these results. Were prejudice and income related
in the same way for the various categories of your control variable? What differences and similarities
can you identify? Which subgroup is more prejudiced? Which is less prejudiced? Explain.
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INDEPENDENT PROJECT 10.1
Is There a Relationship Between Sexism and Prejudice?

NAME

INSTRUCTOR

DATE

Is sexism related to racial prejudice? Do people who support more restricted roles for women also see
black Americans as innately inferior? Use RACDIF2 as a measure of racial prejudice and run the
Crosstabs procedure—with column percentages, chi-square, and gamma—with RACDIF2 as the column
variable and FEFAM as the row variable. If sexism and prejudice are related, the relationship between
these variables will be significant and substantial. Use the output to complete Item 1.

Is there a relationship between sexism or prejudice and political ideology? Run the Crosstabs procedure
again with POLVIEWS as the column variable and first RACDIF2 and then FEFAM as row variables.
Don’t forget column percentages, chi-square, and gamma. Use the output to complete Items 2 and 3.

1. Summarize results for RACDIF2 and FEFAM by completing the following table. Fill in the blanks
with the percentage of respondents who were sexist (“agree” on FEFAM) for each category of
RACDIF2. Remember that we take a response of “yes” on RACDIF2 as an indication of prejudice.

Sexism by Prejudice
Prejudice
Sexism Yes (prejudiced) No (not prejudiced)
Percentage Sexist
(“Agree” on FEFAM)
Chi-square = p= Gamma =
2. Summarize the results.

a. The column percentages (do/do not) change, so there (is/is not) a relationship
between these variables.

b. Chi-square for this relationship is and the value for p is (less than/more than) .05,
so this relationship (is/is not) statistically significant.

c. The value of gamma is , so this is a (weak/moderate/strong) relationship.

d. The sign of gamma indicates that this is a (positive/negative) relationship. As prejudice
increases, sexism (increases/decreases). Be careful in interpreting direction.

3. Are sexism and prejudice related? How? Describe the relationship.
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4. Summarize the results for the relationship between prejudice (RACDIF2) and political ideology
(POLVIEWS) by completing the following table. Fill in the blanks with the percentage of respondents

who were prejudiced (“yes” on RACDIF2) for each category of POLVIEWS.

Prejudice by Political Ideology
Political Ideology
Prejudice Liberal Moderate Conservative
Percentage Prejudiced
(“Yes” on RACDIF2)
Chi-square = p= Gamma =
5. Summarize these results:

a. The column percentages (do/do not) change, so there (is/is not) a relationship
between these variables.

b. Chi-square for this relationship is and the value for p is (less than/more than) .05,
so this relationship (is/is not) statistically significant.

c. The value of gamma is , so this is a (weak/moderate/strong) relationship.

d. The sign of gamma indicates that this is a (positive/negative) relationship. As political
views become more conservative, traditional prejudice (increases/decreases). Be careful

in interpreting direction.

6. Are prejudice and political ideology related? How? Describe the relationship.

7. Summarize results for the relationship between sexism (FEFAM) and political ideology (POLVIEWS)
by completing the following table. Fill in the blanks with the percentage of respondents who were

sexist (“agree” on FEFAM) for each category of POLVIEWS.

Sexism by Political Ideology
Political Ideology
Sexism Liberal Moderate Conservative
Percentage Sexist
(“Agree” on FEFAM)
Chi-square = p= Gamma =
8. Summarize these results.

a. The column percentages (do/do not) change, so there (is/is not) a relationship
between these variables.

b. Chi-square for this relationship is and the value for p is (less than/more than) .05,
so this relationship _ (is/is not) statistically significant.

c. The value of gamma is , so this is a (weak/moderate/strong) relationship.

d. The sign of gamma indicates that this is a (positive/negative) relationship. As political
views become more conservative, sexism (increases/decreases). Be careful in

interpreting direction.

9. Are sexism and political ideology related? How? Describe the relationship.



238 EXPLORING SOCIAL ISSUES
INDEPENDENT PROJECT 10.2
Other Causes of Prejudice
NAME
INSTRUCTOR
DATE

Repeat the analysis of the causes of prejudice you did in Research Report 10.3 with two new
independent variables (Do not use SEX.)

1.

3.

Identify and explain your independent variables:
a. “SPSS” names:

b. Explain exactly what each variable measures:

Your first independent variable:

Your second independent variable:

. State a hypothesis for the relationship between each of your independent variables and RACDIF2.

Use your textbook and other course materials, if relevant, to help you develop hypotheses. If
appropriate for your variables, state the anticipated direction of the relationship (positive or
negative). Explain why you expect a relationship between these variables:

Your first independent variable:

Your second independent variable:

Present your results for your first independent variable and RACDIF2:

a. On Line 1 of the following summary table, state the name of your first independent variable. Use
common words, not SPSS variable names.

b. On Line 2, write in the name of your first independent variable, again using common words.

c. On Line 3, write in the names of the categories of your first independent variable, using as many
blanks as necessary.
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d. On Line 4, fill in the blank with the percentage of respondents who were prejudiced (said “yes”
on RACDIF2) for each category of the independent variable.

e. On Line 5, enter the values for each of the statistics.

1. Anti-Black Prejudice by
2.
3. Prejudice
4. Percentage
“Yes”
S. Chi-square = p= Cramer’s V or Gamma =

4, Summarize these results.

a. The column percentages (do/do not) change, so there (is/is not) a relationship
between these variables.

b. Chi-square for this relationship is and the value for p is (less than/more than)
.05, so this relationship (is/is not) statistically significant.

If the independent variable is NOT numerical:

c. The value of Cramer’s V is , so this is a (weak/moderate/strong) relationship.

d. The pattern of the relationship is that highest level of prejudice is associated with
(identify the category of the independent variable that had the highest percentage of prejudiced
respondents).

If the independent variable IS numerical:

e. The value of gamma is , so this is a (weak/moderate/strong) relationship.
f. The sign of gamma indicates that this is a (positive/negative) relationship. As
increases, prejudice (increases/decreases). Be careful in interpreting direction.

5. Was your hypothesis confirmed? How?

6. Present your results for your second independent variable and RACDIF2:

a. On Line 1 of the following summary table, state the name of your second independent variable.
Use common words, not SPSS variable names.
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b. On Line 2, write in the name of your second independent variable, again using common words.

c. On Line 3, write in the names of the categories of your second independent variable, using as
many blanks as necessary.

d. On Line 4, fill in the blank with the percentage of respondents who were prejudiced (said “yes”
on RACDIF2) for each category of the independent variable.

e. On Line 5, enter the values for each of the statistics.

1. Anti-Black Prejudice by
2.
3. Prejudice
4. Percentage
“Yes”
S. Chi-square = p= Cramer’s V or Gamma =

7. Summarize these results:

a. The column percentages (do/do not) change, so there (is/is not) a relationship
between these variables.

b. Chi-square for this relationship is and the value for p is (less than/more than) .05,
so this relationship (is/is not) statistically significant.

If the independent variable is NOT numerical:

c. The value of Cramer’s V is , so this is a (weak/moderate/strong) relationship.

d. The pattern of the relationship is that highest level of prejudice is associated with
(identify the category of the independent variable that had the highest percentage of prejudiced
respondents).

If the independent variable IS numerical:

e. The value of gamma is , so this is a (weak/moderate/strong) relationship.
f. The sign of gamma indicates that this is a (positive/negative) relationship. As
increases, prejudice (increases/decreases). Be careful in interpreting
direction.

8. Was your hypothesis confirmed? How?
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INDEPENDENT PROJECT 10.3
Multivariate Analysis of Prejudice

NAME

INSTRUCTOR

DATE

1. Pick one of the bivariate relationships you examined in either Research Report 10.3 or Independent
Project 10.2. If possible, pick a relationship in which the relationship was statistically significant
(p < .05) and at least moderately strong. What happens to this bivariate relationship when you
control for SEX? Run the Crosstabs procedure with RACDIF2 in the rows, your independent
variable in the columns, and SEX as the control variable. Get column percentages, chi-square, and
either Cramer’s V (if your independent variable is not numerical) or gamma (if your independent
variable is numerical) as your measure of association.

2. Complete the following summary table to display your results for the full sample (“all”) and for men
and women separately.

a. In Line 1, fill in the blank with the name of your independent variable, using common words not
the SPSS variable name.

b. In Line 2, write in the name of your independent variable, again using common word(s).

c. In Line 3, write in the names of the categories of your independent variable, using as many blanks
as necessary.

d. In Line 4, fill in the percentage of prejudiced respondents (“yes” on RACDIF2) for each category
of the independent variable. The information for this line can be copied from Research Report 10.3
or Independent Project 10.2.

e. In Line §, fill in the percentage of prejudiced men for each category of the independent variable.
In Line 6, do the same for women.

1. Anti-Black Prejudice by by Sex
2.
Percentage Significance ~ Cramer’s
Prejudiced of chi-square V or
Gamma
4. Al
S. Men
6. Women

3. Use the column percentages and the measure of association to analyze these results. Were prejudice
and your independent variable related in the same way for both men and women? What differences
and similarities can you identify? Which subgroup is more prejudiced? Which is less prejudiced?
Explain.
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INDEPENDENT PROJECT 10.4
Opposition to Immigration

In Exercise 10.5 we explored the idea that one cause of prejudice is competition between groups and
the sense of threat—the more threatened a person feels by members of another group, the greater his
or her prejudice. In this Project, you will apply this idea to attitudes about immigration to the United
States. The rate of immigration has been very high for the past few decades and many people are very
concerned about the issue. Some people believe that the nation should drastically decrease the number
of immigrants admitted each year, and others believe that high rates of immigration are not a particular
problem.

What are the sources of these varied feelings about immigration? Why are some people so committed
to reducing the number of newcomers entering the society? Clearly, there are multiple reasons for each
person’s views, and some are the result of careful reasoning and an objective assessment of the problem.
The views of other people, however, may be tainted with prejudice and the perception that immigrants
are a threat to the primacy of American culture or the English language, to jobs or housing, to the local
school or welfare system, or to many other areas.

We can test the possibility that a sense of threat is shaping attitudes toward immigration with the 2006
GSS. One item on the survey (LETIN1) asks respondents if they think that the number of immigrants
in America today should be reduced, remain the same, or increased. Another item (SATFIN) asks
respondents about their satisfaction with their present financial situation. Assuming that people who are
financially dissatisfied are more likely to feel threatened and insecure, are they also more opposed to
immigration?

Before testing this hypothesis, it seems reasonable to eliminate Hispanic Americans and Asian
Americans—both of whom have a high percentage of recent immigrants—from the test. Do this by
selecting only white and black Americans in the GSS-2006-Tabular file, as specified in the following
commands:

COMMAND BLOCK 10.3 Selecting White and Black

Americans Only

¢ Click Data > Select Cases

e From the Select Cases dialog box, click If condition is satisfied

o Click If

¢ In the Select Cases: If dialog box, highlight RACEETH and click the right-pointing arrow

e Click the < = sign and the number 2 from the calculator pad. This will select all cases that have a
score equal to (=) or less than (<) 2 on RACEETH. Recall that whites are scored as a 1 and blacks
as 2

¢ Click Continue

e Click OK

e When you have the output you need, don’t forget to return to the Data = Select Cases command

and click Reset to restore the sample to its original composition

Use the Frequencies procedure for LETIN1 to examine the structure of public opinion on the
immigration issue and use the output to complete the first item below. Next, use the Crosstabs
procedure and name SATFIN as the independent variable (in the columns) and LETIN1 as the
dependent variable. Don’t forget to request chi-square, gamma, and column percentages.
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1. How do Americans feel about immigration? About % feel that the number of immigrants should
be reduced and about % feel that the number should be increased.

Based on these results, it seems fair to say that Americans are (in favor of/against/unsure
about) immigration.

2. Summarize the results of the Crosstabs procedure by completing the table.
a. On Line 4, fill in the blanks with the percentage of respondents who believe that the number of
immigrants should be reduced for each level of financial satisfaction.
b. On Line 3, enter the values for each of the statistics.

1. Atstitude Toward Immigrants by Satisfaction With Finances
2. Satisfaction With Finances
3. Attitude on Immigrants Pretty Well More or Not Satisfied
Satisfied Less Satisfied at All
4. Percentage “Reduced”
Chi-square = p= Gamma =
3. Summarize these results:
a. The column percentages (do/do not) change, so there (is/is not) a relationship
between these variables.
b. Chi-square for this relationship is and the value for p is (less than/more than) .05,
so this relationship (is/is not) statistically significant.
c. The value of gamma is , so this is a (weak/moderate/strong) relationship
d. The sign of gamma indicates that this is a (positive/negative) relationship. As

satisfaction with finances increases, support for reducing the number of immigrants
(increases/decreases). Be careful in interpreting direction.

Multivariate Analysis

4. The idea that a sense of threat can shape attitudes toward immigrants might apply most to people
who have the fewest resources in the first place. Examine the relationship between LETIN1 and
SATFIN again, this time controlling for INCOME. Are people at the lowest income level the most
likely to feel that the number of immigrants should be reduced?

1. Attitude Toward Immigrants by Satisfaction With Finances by Income
2. Satisfaction With Finances
Pretty Well More or Not Significance
Satisfied Less Satisfied of Chi-
Satisfied at All Square Gamma

4. Attitude on Immigrants
(Percentage “Reduced”)

Low Income

Moderate Income

High Income

(Continued)
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(Continued)

5. Use the column percentages and gamma to analyze these results. Were attitudes about immigration
and financial satisfaction related in the same way for all income levels? What differences and
similarities can you identify? Which subgroup is most likely to feel that the number of immigrants
should be reduced? Which is least likely? Overall, do these results support the idea that attitudes
toward immigration are shaped by a sense of threat? How?
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COMPARATIVE ANALYSIS 10.1
Has Racial Inequality Changed Over Time?

NAME

INSTRUCTOR

DATE

Repeat the analysis done in Research Report 10.1, using the 1972 General Social Survey. Construct
multiple line charts for EDUC, PRESTIGE, and INCOME72 by RACE and complete the following
statements.

1. On years of education (EDUC), whites were generally (higher than/lower than/equal to)
blacks. This chart indicates that the races (were/were not) equal in level of education in
1972.

2. For occupational prestige (PRESTIGE), whites were generally (higher than/lower
than/equal to) blacks. This chart indicates that the races (were/were not) equal in prestige
in 1972.

3. For income (INCOME?72), whites were generally (higher than/lower than/equal to) blacks.
This chart supports the conclusion that there (was/was not) racial equality in the United

States in 1972.

4. Compare these results with Research Report 10.1. Can you tell if the amount of racial inequality
declined or increased between 1972 and 2006? Explain.
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COMPARATIVE ANALYSIS 10.2
Testing For the Significance of the
Difference in Racial Inequality in 1972
NAME
INSTRUCTOR
DATE

Repeat the analysis done in Research Report 10.2, this time using the 1972 GSS. Run T Test with
EDUC, PRESTIGE, and INCOME?72 as the testing variables (WEALTH was not included in the 1972
GSS) and RACE as the grouping variable. Complete the following summary tables to display the results.

p (“Sig. 2
Variable Groups N Mean  Std. Dev.  t Score  Tailed”)
Education (EDUC) Whites
Blacks
Income INCOME?72) Whites
Blacks
Prestige (PRESTG80)  Whites
Blacks
. In 1972, whites averaged (more/fewer) years of education than blacks, and the difference
(was/was not) significant.
. In 1972, the average occupational prestige for whites was (higher/lower) than blacks, and
the difference (was /was not) significant.
. In 1972, whites had a (higher/lower) average income than blacks, and the difference
(was/was not) significant.
. Summarize these results. How much racial inequality existed in 1972? Was inequality greater in 1972

or in 2006? Explain.
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COMPARATIVE ANALYSIS 10.3
PREJUDICE IN 1972

NAME

INSTRUCTOR

DATE

Unfortunately, because RACDIF2 and RACDIF4 were not included in the 1972 GSS, the levels of
prejudice cannot be directly compared with 2006. (Other measures of prejudice were asked in both
years but, because of space limitations, none of these are included in the data set supplied with this text.)
Instead, you can conduct a test to see if the causes of prejudice were the same in both years.

Using the GSS-1972 data set, measure prejudice with the variable RACPRES, which asked
respondents if they would vote for a black candidate for president who was nominated by their party
and otherwise qualified. Assume that those who answered “no” are prejudiced. Choose an independent
variable from the 1972 data set that matches one of the independent variables you used for Research
Report 10.3 or Independent Project 10.2 and run the Crosstabs procedure (with column percentages,
chi-square, and Cramer’s V or gamma) to analyze the relationship.

Compare your 1972 results for RACPRES with the 2006 results for RACDIF2. If prejudice is shaped
by similar causal processes in both years, the bivariate relationships should be similar in spite of the
substantial differences in dependent variables. What can you conclude? Have the correlates of prejudice
changed over the years? How? Report your results below and be sure to include all relevant statistical
information.
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MAIN POINTS

e This chapter conducted an investigation of racial inequality and prejudice, which par-
alleled the investigation of gender inequality and sexism in Chapter 9.

e Line charts and #-tests were used to explore racial inequality for level of educational
attainment, occupational prestige, wealth, and income.

e Crosstab tables and the elaboration technique were used to measure levels of prejudice
and to seek the causes of these attitudes.

e The distinction between traditional, overt prejudice and modern, more subtle forms of
prejudice was explored and we tried to ascertain if racial prejudice is truly declining or
merely changing forms.

GLOSSARY OF KEY CONCEPTS

Prejudice: Negative attitudes, feelings, and stereotypes about other groups.

SPSS COMMANDS INTRODUCED IN THIS CHAPTER

COMMAND BLOCK 10.3 Selecting White and Black

Americans Only

¢ Click Data > Select Cases

¢ From the Select Cases dialog box, click If condition is satisfied

e Click If

¢ In the Select Cases: If dialog box, highlight RACEETH and click the right-pointing arrow
* Click the = sign and the number 2 from the calculator pad

¢ Click Continue

e Click OK
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